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FAAST LT 
FIRE ALARM ASPIRATION SENSING TECHNOLOGY®

ADVANCED SET-UP AND CONTROL GUIDE

INTRODUCTION

The FAAST LT aspirating smoke detector is an advanced smoke 
sensing system for use in early warning and very early warning 
applications. The system continuously draws air from the controlled 
environment through a series of sampling holes to monitor the 
environment for smoke particulate. A range of sensing, operating 
and output facilities can be configured in the FAAST LT unit by the 
end user. This is accomplished by programming and downloading 
control parameters from a PC running the proprietary software 
application, PipeIQLT. This manual describes how to monitor and 
configure the various operating parameters available in a FAAST 
LT unit via the user interface provided by PipeIQLT. 
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THE FAAST LT FUNCTIONAL STATE DIAGRAM.

In operation, the device can be in one of 6 possible states: 

Initialization

Normal

Maintenance

Remote Maintenance

Service Mode

Power Out Of Range state

The routes in and out of these states are shown in the diagram 
below.
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USING PIPEIQLT TO CONTROL OR MONITOR FAAST LT

FAAST LT USB Connection
PC connectivity is provided by an on board USB B socket located 
in the middle of the FAAST LT unit behind the hinged front cover. 
The USB interface allows access to a range of additional options, 
via the PipeIQLT application software (supplied). 

Note: To connect, access or change any FAAST LT configuration 
parameters, the device must be in Maintenance mode (See 
Password Procedure to enter Maintenance mode).

Connecting a PC to a FAAST LT Device for the First Time
PCs Running Windows 7
Ensure that PipeIQLT is installed on the PC, and that the FAAST 
LT unit is running in Maintenance mode. With Windows 7 running, 
connect the USB cable from the FAAST LT device to a spare USB 
port on the PC. The PC will automatically detect the new hardware 
and find and install the necessary driver software. When this is 
complete, a message will appear in the bottom right corner of the 
screen (the FAAST LT device can be viewed in the Ports (COM & 
LPT) field of Device Manager).

PCs Running Windows XP
Ensure that the FAAST LT unit is running in Maintenance mode. 
The first time that a PC running Windows XP is connected to the 
FAAST LT device, the Windows ‘Plug and Play’ dialog box will pop 
up on the screen, alerting that a new hardware device has been 
found and needs to be connected. 

Choose the following options:

Power-On/Initialisation
A FAAST LT device always powers on in the Initialisation state where 
internal checks are completed before entering the Normal state.

Normal
In the Normal state the FAAST LT operates as a smoke detector. 
The main button actions are not active, apart from the combination 
Reset + Disable which shows the fan speed number, and the 
Reset button itself providing access to the Password Procedure to 
go to the Maintenance state.

Note: For the loop based FAAST LT device, the module address 
will only respond to a panel poll when in Normal mode.

Maintenance
When the correct password is entered, a FAAST LT device will 
enter the Maintenance state (See Password Procedure for more 
information). The front panel buttons are enabled for maintenance 
functions and the FAAST LT unit can be linked to a PC. (See 
Remote Maintenance state).

A FAAST LT device will automatically time-out of the Maintenance 
state after a preset period of inactivity (Default is 5 minutes). 

Remote Maintenance
To enter the Remote Maintenance state from the Maintenance 
mode, open the hinged front cover and connect to a PC with a USB 
cable. In Remote Maintenance state it is possible to control, monitor 
and re-programme the FAAST LT device via the PC using PipeIQLT.

The Remote Maintenance state does not have a time-out. The 
FAAST LT device will return to the Maintenance state when the 
USB cable is unplugged.

Service Mode
When the FAAST LT device is in Normal, the Service Mode state is 
entered automatically when the front cover is opened. The FAAST 
LT unit switches off the power to the unit. Once the service action 
is complete, and the front cover is closed, the FAAST LT device 
restarts automatically.

Power Out Of Range State
If the PSU voltage is out-of-range, the FAAST LT unit will stop 
working, switching off the power to the unit and signalling a power 
fault and a general fault.

The FAAST LT device remains in this state until it is re-powered or 
restarts automatically when the supply voltage returns to within the 
correct range.

PASSWORD PROCEDURE (To enter Maintenance Mode)
Press and hold RESET; left hand flow indicator will turn yellow 
then green.

Release RESET and FAULT indicator will switch on green. The left 
hand flow indicator will blink green indicating the device is ready 
for the first digit.

Press DISABLE to increment the LEDs 1…9; press TEST (tick 
button) to select a digit.

The flashing airflow segment will turn solid green and the next 
segment will begin to flash indicating set the next digit. When the 
4th digit is selected, all 4 airflow segments are turned off. If the 
password is accepted the FAULT indicator will remain green and 
the unit enters Maintenance mode. If the password is incorrect 
the FAULT indicator flashes yellow and the unit remains in Normal 
mode. The Default password in 3111.

If no button is pressed for 10s during the password sequence, the 
unit returns to Normal mode. If there is no activity in Maintenance 
mode for 5 minutes (default), the fault indicator blinks green for 15s 
and then the unit returns to the Normal state.

When the USB cable is plugged into the unit, it switches to Remote 
Maintenance mode; the maintenance time-out is disabled.

AN INTRODUCTION TO PIPEIQLT™

Overview 
The PipeIQLT software program is a convenient and powerful 
Windows® based application that can be used to set-up and 
monitor the performance of FAAST LT Aspiration devices via a 
graphical user interface on a PC.

PipeIQLT also provides facilities to develop and verify the 
performance of pipe network solutions, configure the design 
parameters to suit local fire codes and standards and generate 
pipe layout diagrams, BoMs, parameter tables and event log 
reports. 

With a detailed Help Menu to guide the user through the different 
screens and options, PipeIQLT is a comprehensive package to 
support the use of the FAAST LT detector in aspirating applications.

Installing and Running PipeIQLT
Load and install PipeIQLT on the PC (See the PipeIQLT Quick 
Start Instructions at the back of the FAAST LT Quick Installation 
Guides for details of installing and launching PipeIQLT).

The PipeIQLT User Interface
The graphical user interface for PipeIQLT includes a title bar, menu 
bar, toolbar, left pane, right pane, and status bar as described in 
the following table:

Option Action 

Menu bar 
Contains six menus that perform various 
tasks such as new, open, close, save, 
change the view, etc 

Toolbar Contains buttons to create, open or save 
projects 

Left pane Displays all the project elements in a tree 
structure 

Right pane Displays detailed information of the item 
selected in the left pane 

Status Bar 
Displays the type of operation (on tabs at the 
bottom of the Left Pane) 
Tabs: Configuration; Pipe Design; Monitoring 
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Select No, not this time and Next to move to the next window:

Select Install the software automatically (Recommended).
Place the PipeIQ LT disc supplied with the FAAST LT unit into the 
CD drive and click Next. Follow the on-screen instructions to install 
the new hardware drivers.

When complete, a window will display the message The wizard 
has finished installing the software for FAAST LT.

Click Finish. The FAAST LT device will appear in Device Manager.

Preparing to Configure or Monitor a FAAST LT Device
To connect and communicate with a FAAST LT device via the 
PC USB port, PipeIQLT must be running a project (.mdf file) that 
matches the type of FAAST LT device being used. If no project 
exists on the PC, one will have to be created prior to connecting 
(See Creating a Project section).

To communicate with a FAAST LT Device.
Ensure that the FAAST LT unit is in Maintenance mode, PipeIQLT 
is running on the PC, and a USB cable is connected from the 
internal socket to the PC.

In PipeIQLT, open the project file associated with the FAAST LT 
device to be monitored. The Left pane in PipeIQLT will show the 
aspirating system tree (loading the file may take a little while).

Click on the FAAST LT Device to highlight it, as shown below:

Select Connect Device from the Tool menu.

Follow the on-screen instructions to make the connection.

The device is connected when a Green Tick is indicated by the 
device. A Red Cross indicates that the device is not connected.

In the Status Bar at the bottom of the left pane, a series of tabs 
allow the user to switch the view as required:

Select the Monitoring/Configuration tab as required.

Monitoring a FAAST LT Device 
Once connected to a FAAST LT device, PipeIQLT can be used to 
monitor the device; it is possible to check the status (read device 
information), review event logs, activate relays, test the fan speed 
and reset the device. 

Open a relevant project, highlight the FAAST LT device, Select 
Connect Device from the Tools menu and make the connection. 
Double click the FAAST LT device to open the large pane on the 
right side of the screen. View the device status features by clicking 
on the Monitoring tab. An additional tab at the top of the pane 
provides access to further features.

Ensuring that the FAAST LT device is highlighted in the left pane, 
Select Device information from the Tools menu to view further  
info.
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The Monitoring screen view is shown in Appendix A. For more 
information on using the Monitoring options, see the PipeIQLT 
Help Menu.

IMPORTANT NOTES ON ALTERING FAAST LT SETTINGS
FAAST LT devices are shipped with factory default parameters that 
should be adequate for many aspirating applications; a list of these 
parameters is shown in Appendix B. If these factory default parameters 
are altered, the validity of the new settings must be confirmed.

Air Flow Settings
The FAAST LT operating settings can only be changed using the 
PipeIQLT application. Pipe layouts should be verified for EN54:20 
compliance by running a PipeIQLT simulation project (via the Pipe 
Design tab) and evaluating the results against the strict approval 
criteria in the program. Sensitivities, air flow rates and limits etc are 
adjusted and optimised within PipeIQLT; the FAAST LT parameter 
values are created in the pipe design project and stored in an 
associated configuration file. The resulting air flow rate should 
be set as the reference flow into the configuration by pressing 
the Apply to Configuration button in the PipeIQLT Pipe Design 
mode, which will automatically set the new airflow limits.

Modifying the reference flow arbitrarily from within the Configuration 
screen is not recommended. Changing the fan speed using the 
manual mode from within the Configuration screen should be 
avoided. These change options are available primarily for test 
purposes only. Manually setting the fan speed to change the air 
flow will not alter the associated hi/lo flow limit settings in the 
FAAST LT unit. Therefore this option should not be used to set 
or change air flow values in an EN54 compliant pipe system; the 
PipeIQLT Pipe Design facility should always be used.

Delay Settings
The default values for flow fault delay, general fault delay, pre-
alarm and alarm delay, and remote output alarm time that are 
pre-set into the FAAST LT unit are critical for compliance to the 
EN54:20 standard. 

Within the Configuration options it is possible to increase delay 
times for these actions, but any changes should be made with 
extreme caution. Increasing any of these delays should not be 
done without a clear understanding of the consequences to the 
requirements of the EN54:20 standard.

Configuring a FAAST LT Device 
The PipeIQLT configuration interface provides a method for 
viewing and editing the device configurations. Once connected to 
a FAAST LT device, PipeIQLT can be used to configure the device; 
it is possible to set up relay actions, fan speed, critical times and 
dates, event log requirements and other operational parameters. 
For the Stand Alone versions it is also possible to configure the 
alarm thresholds.

With the Configuration options selected, the General tab displays 
in the right pane, with further options available using the Advanced 
button (details such as passwords, time-outs and external input 
information). If a new project was created, the initial screen display 
will show the factory default settings for the device type selected. 

Select the Alarms and Relays tab to show details such as relay 
latching, alarm mode settings and delays.

Select the Channels and Sensors tab to show details such as fan 
speed settings and sensor or channel disablement.

The Configuration screen views are shown in Appendix A.

Note: There are some differences between the graphic screens 
for the FAAST LT stand alone and loop based units, owing to the 
variation in control and operation between the two.

For more information on using the Configuration options, see the 
PipeIQLT Help Menu.

Follow the steps below to configure a FAAST LT device. 

1)	 Open a relevant project, highlight the FAAST LT device, Select 
Connect Device from the Tools menu and make the connection. 
Double click the FAAST LT device to open the large pane on 
the right side of the screen. View the device settings by clicking 
on the Configuration tab. At this point, the screen will show the 
configuration from the current project file, NOT the actual 
device configuration.

2)	 Ensuring that the FAAST LT device is highlighted in the left 
pane, Select Get Configuration from the Tools menu; the 
FAAST LT current configuration parameters will be uploaded 
from the device and shown on the PC screen. Note that this 
uploaded data from the device will overwrite the configuration 
file values in the current project.

3)	 Set the configuration as required and click Apply, then OK.

4)	 To save this new device configuration in the current project 
select Save from the File menu, or to save as a new project 
select Save As from the File menu and enter a new filename.

5)	 To actually change the operating settings in a FAAST LT 
device, it is necessary to connect to the unit and send 
across the configuration file using the USB link; see 
Sending a Configuration to a FAAST LT Device section.

Sending a Configuration to a FAAST LT Device
The Send Configuration option in PipeIQLT will download the saved 
configuration settings from a PC to a FAAST LT device. Before 
sending the configuration information, ensure that the device is 
connected and communicating with the PC.

Select the Configuration tab. 

In the left pane, right-click the device and then choose the Send 
Configuration option, or choose Send Configuration from the 
Tools menu.

Enter the Maintenance Password into the dialogue box and click 
Download.

A confirmation message appears. Click OK.

Note: When a new configuration is downloaded to a FAAST 
LT device, the new parameters are not used immediately; it is 
necessary to exit from the Maintenance mode. Disconnect the PC 
and remove the USB cable, close the front cover and then wait 
for the Maintenance mode time-out (or press the three front panel 
buttons for 2 seconds - see the FAAST LT Quick Installation Guide) 
and allow the device to restart.

Remember that the data uploaded from the FAAST LT device 
will overwrite the configuration file in the current project. It is 
recommended that a copy of the original configuration is made 
and stored before any changes are made to the FAAST LT control 
parameters (after selecting Get Configuration from the Tools menu, 
select Save As from the File menu). 

For more information on using the Configuration options, see the 
PipeIQLT Help Menu.

Time and Date: Setting the Real Time Clock
The time and date clock in the FAAST LT device is set up 
independent of the configuration parameters. 

With the Monitoring tab selected in the left pane and the FAAST 
LT device highlighted, ensure that the Actions tab is selected in the 
right pane. The clock configuration section is located in the  bottom 
left of this pane. 

Click Get to refresh the date and time display.

Click on Change FAAST LT Clock to adjust the date and/or time. 
Follow the on-screen instructions and then click Update. Click OK 
to finish. The clock is immediately reset.
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To set these levels, ensure the Configuration tab is selected in 
the left pane and click the Advanced button in the Channels and 
Sensors tab of the right pane. Set the required alarm value from 
the drop down menu.

Using the Day/Night mode, a second set of Alarm and Pre-Alarm 
levels can be configured.

In the common chamber version of the FAAST LT ( 1 channel - 2 
detectors), it is possible to configure the detector to give alarm 
when only 1 sensor (OR) or when both sensors (AND) reach the 
alarm level. 

FAAST LT Alarm Mode (Loop based version only)
For a FAAST LT device that uses loop communication the smoke 
alarm decision is made at the panel. The panel can activate an 
Alarm status at the FAAST LT unit in one of two ways, pre-settable 
in the configuration parameters.

Sensor Alarm Mode
In this mode, the FAAST LT unit monitors the sensors’ remote 
outputs; these are under the control of the panel. When the panel 
sets the remote output ON, the related sensor channel will go into 
alarm; when the remote output turns OFF, the channel will exit the 
alarm state.

Module Alarm Mode
In this mode the FAAST LT Alarm state is controlled via the channel 
module. When the panel sends the output activation ON command 
to a channel module, the related channel will go into alarm. To 
exit the alarm state the panel must send the output activation OFF 
command to the module address.

Note: When the FAAST LT device is set to Sensor Alarm Mode 
and an output activation ON command has been sent to the 
module address, no alarm LEDs or alarm relay activation will be 
performed. Also, when the FAAST LT device is in Module Alarm 
Mode the alarm latching options are not allowed.

Setting the FAAST LT Device Fan speed 
Before leaving the factory, an air velocity reference value is set 
into each FAAST unit. This equates to an optimum air flow of 
approximately 45 l/min. Default high/low flow thresholds are set to 
guarantee a flow fault when the air flow is ±20% of the reference 
flow. The FAAST LT fan speed in each channel can be set to Auto 
or Manual control.

Auto Mode 
In automatic fan speed mode, the unit will automatically initialise to 
the best fan speed related to the reference flow value at power ON. 

Manual Mode
In manual fan speed mode, the unit uses the configured fan speed, 
and does not initialise the flow relative to the pre-set reference flow 

PREALARM / ALARM 
LEVEL Obs in %/Feet Obs in %/meter 

Level 1 0,02 % obs/ft 0,07 % obs/m 
Level 2 0,03 % obs/ft 0,10 % obs/m 
Level 3 0,05 % obs/ft 0,16 % obs/m 
Level 4 0,10 % obs/ft 0,33 % obs/m 
Level 5 0,20 % obs/ft 0,66 % obs/m 
Level 6 0,50 % obs/ft 1,64 % obs/m 
Level 7 1,00 % obs/ft 3,28 % obs/m 
Level 8 1,50 % obs/ft 4,92 % obs/m 
Level 9 2,00 % obs/ft 6,56 % obs/m 

 

Setting the Alarm Level (Stand Alone Versions Only)
The FAAST LT detector uses an internal laser smoke sensor in 
each channel. The laser sensor has 9 sensitivity levels allowing 9 
different Alarm or Pre-Alarm settings to be available in the detector; 
these are shown in the table following:

value. The fan speed can be set to operate in the range between 1 
and 10 (highest speed).

Fan Speed Test
It is possible to test the fan speed setting using PipeIQ LT.

The FAAST LT device must be connected and communicating with 
the PC.

Select the Monitoring tab in the left pane and highlight the FAAST LT 
device to be tested; the Actions tab will appear in the right pane. In 
the Test Fans Speed box, select the desired fan speed against the 
required channel with the slider. Click Test Fan; after a short period 
the Flowrate will be displayed. To terminate the test, click Stop.

FURTHER PIPEIQLT CAPABILITIES

Creating a Project
To create a project select New from the File menu or click on the 
toolbar. 

The New Project dialog box appears.

In the File Name box, type the name of the project, and then click 
Save. 

The PipeIQ LT project file is created.

A project can comprise a site, buildings, floors, and devices. When 
creating a project, these items are created by default; they must 
be defined before designing the pipe layout. For information on 
configuring elements on a site, see the PipeIQLT Help (select 
PipeIQLT Help from the Help menu. 

Note: It is possible to add new buildings, floors and devices to 
a project after the initial site configuration is complete. Editing or 
modifying a project is carried out in the Configuration mode; for 
more information on adding elements to a project, refer to the 
PipeIQLT Help Menu.

Designing a Pipe Layout
To create an effective layout, the designer must have knowledge 
of the following:

Local codes and standards for the site

Pipe network design

Creating layouts using drawing packages (e.g. AutoCAD® software) 
and similar tools producing DXF format files.

For more information on using the Pipe Design Application Tools, 
see the PipeIQLT Help Menu.

Creating Reports
PipeIQLT can generate the following reports. 

Configuration Reports

Event Log Report

Pipe Layout

Bill of Materials.

For more information on using the Report options, see the PipeIQLT 
Help Menu.

PipeIQ LT Help
The online help is a guide through the PipeIQLT application. The 
Help opens in a separate window where it is possible to search 
and navigate to information on different topics.

Select PipeIQLT Help from the Help menu or press F1. When you 
press F1 the help topic for the active window is invoked. 

Using Help - Navigation Pane (Left Pane)
This pane includes Contents, Search and Index tabs. Click on the 
tab to access the content of each.

Index: This tab contains a multilevel list of keywords and keyword 
phrases. To open a topic in the Display pane (Right pane) associated 
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with a keyword, double click the keyword. If the keyword is used in 
more than one topic, a dialog box is displayed so you can select 
the topic to view, and then click Display or double-click the topic.

Search: This tab helps you to search for a topic or content. Type 
the word to search and press Enter on the keyboard. The list of 
topics is displayed below. Double click the topic to show it in the 
Display pane. 

Contents: This tab lists the Table of Contents that contains 
categorized books and pages. When you double click a closed 
book it opens to display its topics, and when you click an open 
book it closes. Double click a topic to show it in the Display pane.

Using Help - Display Pane (Right Pane)
The Display pane on the right of the online help displays the 
content for the selected topic.

Blue Underlined Text Indicates a link to a different topic. 

Green Italicized Text Indicates a link to more information or 
images in the same topic. Re-click the link to hide the information 
or image.
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A1: CONNECTING TO A DEVICE

APPENDIX A
MONITORING AND CONFIGURATION INTERFACE

Device connected.
(Green tick on icon)

Device not connected.
(Red cross on icon)

A2: MONITORING MODE PANES
Actions Tab - Stand Alone Versions
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Actions Tab - Loop Based Versions

Log Tab



D200-100-00 9 I56-3888-001

Setting the Clock
(Facility located in the Actions tab)

Use Get to retrieve the current time and date.

Use Change FAAST LT Clock to reset the time and date (to show 
Clock Set view opposite).

Display Device Information

Device Information window (1) Device Information window (2)
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A3: CONFIGURATION MODE PANES AND OPTIONS

Configuration Options

Options:
Send Configuration

Get Configuration

Configuration Reports

Device Information

Disconnect Device

General Tab

Clicking the Advanced button in the General tab displays additional 
configuration settings - there will be different options available for 
Stand Alone and Loop Based versions.

Advanced Configuration Parameters - Stand Alone Versions

Select tabs as required within this window.
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Advanced Configuration Parameters - Loop Based Versions

Select tabs as required within this pane.

Channels and Sensors Tab

Alarms and Relays Tab
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A4: OTHER FEATURES

Generating a Configuration Report

PipeIQ Report Viewer

The configuration report will be multiple pages. Use the arrows on 
the toolbar to navigate through the pages, zoom or print the report.
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Sending the Configuration to a FAAST LT Device

PipeIQLT Help

Contents Tab

Index Tab
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B1: FAAST LT CONFIGURATION PARAMETERS
All the FAAST LT configurable parameters are described in Table 
AB1 below. The default values set into the unit at manufacture are 
listed in Tables AB2 and AB3. The user can change parameter 
values using the PipeIQLT application software that runs on a PC 
and then upload the new configuration into the unit. 

SA denotes a Stand Alone unit

LB is a Loop Based (addressable) unit

A a denotes applicable

APPENDIX B
FAAST LT CONFIGURATION PARAMETERS AND DEFAULT SET-UP VALUES

Table AB1: FAAST LT Configuration Parameters

# PARAMETER PARAMETER 
RANGE SA LB DESCRIPTION COMMENTS 

1 Maintenance Password 1111 - 9999   4 digit code required to enable front panel 
push buttons and access Maintenance 
mode .  

 Factory default password 3111. 

2 Current configuration 
number 

0 . .255   Number used to identify the current device 
configuration. Every time the configuration is 
changed, this number is incremented .  

Factory default is 1 .  
When 255 is reached the 
number rolls back to 0 

3 Current configuration 
date 

DD/MM/YY 
HH:MM:SS 

  Date/Time of last device configuration 
upload . 

4 Channel 1 enabled YES/NO   YES: Channel is enabled and operating as a 
smoke detector . 
NO: Channel is disabled . 

Only possible with 2 channel 
units; cannot disable both 
channels at the same time . 

5 Channel 2 enabled YES/NO  

6 Sensor 1 enabled YES/NO   YES: Sensor is enabled and operating as a 
smoke detector . 
NO: Sensor is disabled 

For 1 channel + 2 sensor version 
only; not possible to disable both 
sensors . 7 Sensor 2 enabled YES/NO  

8 Daylight saving enabled YES/NO/AUTO   Allows the real time clock date to change for 
a daylight saving period (+1 hour) 

NO: Daylight saving off. YES: 
period is specified by parameters 
9 and 10. 
AUTO: sets start date to last 
Sunday in March and end date 
to last Sunday in October . 

9 Daylight saving start 
date  

DD/MM HH:MM   Start date/time of daylight saving period Used when daylight saving is set 
to YES.  

10 Daylight saving end 
date  

DD/MM HH:MM   End date/time of daylight saving period 

11 Disable time 1..240 min   When disabled the device stops reporting 
alarms and faults for this period . 

When the time expires or 
RESET is pressed, device 
returns to Normal state . 

12 Maintenance timeout 1..30 min or 0 (Not 
Used) 

  Sets the period of inactivity after which a unit 
will return to Normal from Maintenance 
mode 

In remote maintenance (USB 
connected) there is no device 
timeout .  

13 Trend log interval 1..240 min or 0 (Not 
Used) 

  Time interval used by a device to regularly 
record its status . 

Events are also logged as they 
occur .  

14 Sensors blinking 
replicated  

YES/NO   NO: No blink  
YES: Channel alarm LED blinks green when 
the detector is in Normal state . 

When channel is in alarm, the 
alarm LED will change to red. 

15 Both supplies monitored YES/NO   NO: Only power supply #1 input is 
monitored . 
YES: Power supply #2 is also monitored 

16 Common chamber 
sensors required for 
alarm 

1,2   Detector alarm logic for common chamber 
model (1 channel x2 sensors):   
1 . OR function – either sensor in alarm  
2 . AND function – both sensors need to be 
in alarm . 

If a sensor is disabled or in fault, 
this parameter is ignored . 

17 Sounder automatic cut-
off time 

0 (Not Used), 
5,10,15,…,600 s 

  Sounders turn off after this time period, 
following activation . 
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# PARAMETER PARAMETER
RANGE SA LB DESCRIPTION COMMENTS

18 Channel 1 alarm is 
latched 

YES/NO   NO: When alarm condition is reached, the 
device activates the alarm relay . When the 
alarm condition is removed the alarm relay is 
deactivated . 
YES: When alarm condition is reached, the 
device activates the alarm relay . When the 
alarm condition is removed the alarm relay 
remains set until the device is reset . 

19 Channel 2 alarm is 
latched 

YES/NO  

20 Alarm delay 0..240 s   When alarm condition is reached, a delay 
period can be introduced before the alarm is 
activated . 

If the detector alarm condition is 
removed before activation, the 
delay is reset . 

21 Auxiliary relay is used 
for channel 2 faults 

YES/NO   NO: Device faults are reported on the fault 
relay; this relay is common on 2 channel 
units .  
YES, the AUX relay will separately report 
CH2 faults; CH1 faults continue to be 
reported on the fault relay . Common faults 
will be reported by both relays . 

Faults common to both channel 
are, for example, ASD EEPROM 
fault, external input fault, etc. 

22 Channel 1 label 16 character (ASCII 
code from decimal 
32 to 127) 

  Provides a label to name a channel in free 
text. 

Example: "Building A" "Building 
B" 

23 Channel 2 label 16 character (ASCII 
code from decimal 
32 to 127) 

 

24 Channel 1 fan speed 
mode 

Manual, Auto   Selects the fan speed control mode The optimal flow though the 
device is about 45 litres/minute. 
Typically, this is equivalent to 
fan speed 5 . 

Low and high flow limits are set 
to meet the EN54 requirements. 
A flow fault is given if the flow 
goes out of the -20% and +20% 
of the reference flow range. 

In Auto mode, following 
initialization, the unit sets the 
fan speed to reach the reference 
flow programmed in the device. 
In Manual mode, the user can 
set the fan speed. 

Use PipeIQ LT to change default 
configuration of the reference 
flow (both modes) and fan 
speed (manual mode). 

25 Channel 2 fan speed 
mode 

Manual, Auto  

26 Channel 1 manual fan 
speed 

1 . .10   Defines the fan speed in manual mode . 

27 Channel 2 manual fan 
speed 

1 . .10  

28 Reference flow for 
channel 1 

32 – 65 litres/min   This value represents the correct flow level 
to maintain . 

29 Reference flow for 
channel 2 

32 – 65 litres/min  

30 High flow threshold for 
channel 1 

Internal Setting   High flow threshold 

31 High flow threshold for 
channel 2 

Internal Setting  

32 Low flow threshold for 
channel 1 

Internal Setting   Low flow threshold 

33 Low flow threshold for 
channel 2 

Internal Setting  

34 Flow fault delay 0..240 s   A delay can be set to stop reporting a flow 
fault for a defined period .  

If the fault condition is removed 
before activation of a fault, the 
delay will be reset . 

35 Channel 1 filter due date DD/MM/YY   Date to clean air filters . When date is 
reached, the device will give a filter fault . 

36 Channel 2 filter due date DD/MM/YY  

37 General fault is latched YES/NO   NO: The general fault relay is activated 
when a fault is present and will reset when 
the fault is removed .  
YES: The general fault relay is activated 
when a fault is present . When the fault 
condition is removed the relay remains set 
until a device reset . 

38 General fault delay 0..240 s   A delay can be set to stop reporting a 
general fault for a defined period .  
If the fault condition is removed before 
activation of a fault, the delay will be reset . 

39 Pressure 68758 – 110000 Pa   Not used .  

40 Power restart alert time 0 (Not Used), 1..240 
s,
255 (no time limit) 

  When the device is switched on, it can give 
a power on alert . The time period for this 
alert signal can be set by the user . 
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# PARAMETER PARAMETER
RANGE SA LB DESCRIPTION COMMENTS 

41 Auxiliary relay set on 
low/high temperature 
alert 

YES/NO   User chooses the event(s) that will 
activate the auxiliary relay. 
NO: not used 
YES: activates the AUX relay 

It is possible to have more than one 
event set the Aux relay. If any one 
of the chosen events occurs, the 
Aux relay will be activated (they are 
combined as an OR function) . 

42 Auxiliary relay set on 
external input in not 
normal state 

YES/NO  

43 Auxiliary relay set on 
low power alert / high 
power fault 

YES/NO  

44 Auxiliary relay set on 
flow fault 

YES/NO  

45 Auxiliary relay set on 
sensor communication 
fault  

YES/NO  

46 Auxiliary relay set on 
power restart alert  

YES/NO  

47 Auxiliary relay is 
latched 

YES/NO   NO: The AUX relay is activated when a 
chosen event is present and will reset 
when the event trigger is removed .  
YES: The general AUX relay is activated 
when a chosen event is present . When 
the event trigger is removed the relay 
remains set until a device reset . 

48 External input normal 
state 

OPEN, SHORT   No action is triggered by the input in this 
state . 
OPEN: requires closed contacts to cause 
an input response . 
SHORT: requires an open circuit to cause 
an input response . 

49 External input triggers 
fault  

YES/NO   User chooses the activity that is triggered 
by the external input. 
NO: not used 
YES: activated by external input.  
Note that only one action can be selected 
at a time . 

Note: External input only active in 
NORMAL state .  

50 External input silences 
sounders 

YES/NO  

51 External input resets 
device 

YES/NO  

52 External input disables 
device 

YES/NO  

53 External input disabling 
time 

1..1440 min   When the external input is used to disable 
the device, this option sets the disable 
period .  

54 Pre-alarm delay 0 (OFF), 1..240 s    A delay can be set to stop reporting a pre-
alarm condition for a defined period .  
If the pre-alarm condition is removed 
before activation of the pre-alarm is 
reported, the delay will be reset . 

55 Pre-alarm and Alarm 
are in cascade 

YES, NO    NO: Alarm (or alarm delay) will activate 
immediately on alarm condition .  
YES: Alarm condition does not activate 
until pre-alarm condition (and related 
delay) has completed . 

58 Day start time HH:MI      Start of daytime mode operation Minimum daytime period = 1 hour . 

59 Day end time HH:MI    End of daytime mode operation 

60 Holiday day #1 date DD/MM    On these days, the device uses the night 
time settings only (every year) . 

00/00 = not used 
Day/Night mode (Parameter 81) 
must be set to YES.  Holidays #2…#19 DD/MM 

79 Holiday day #20 date DD/MM 

80 Sounder activation 
mode 

On Pre-alarm, On 
Alarm 

   This option defines which event will 
activate the sounder relay . 

If “On Pre-Alarm” is selected, 
sounders remain active in alarm . 

81 Day/night mode 
enabled 

YES/NO    Allows use of two different sets of alarm 
and pre-alarm levels. 
NO: Day settings are always used 
YES: Device will change between day and 
night settings at selected times . 
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# PARAMETER PARAMETER 
RANGE SA LB DESCRIPTION COMMENTS

82 Monday is holiday YES/NO    Allows use of different alarm and pre-
alarm levels on one or more days of the 
week 
NO: Device will change between day and 
night settings at selected times (if 
Parameter 81 set). 
YES: Night settings are always used  

83 Tuesday is holiday YES/NO 

84 Wednesday is holiday YES/NO 

85 Thursday is holiday YES/NO 

86 Friday is holiday YES/NO 

87 Saturday is holiday YES/NO 

88 Sunday is holiday YES/NO 

89 Sensor 1 day alarm 
level 

1..9    Day and night pre-alarm and alarm level 
settings . 

90 Sensor 2 day alarm 
level 

1..9 

91 Sensor 1 day pre-alarm 
level 

1..9 

92 Sensor 2 day pre-alarm 
level 

1..9 

93 Sensor 1 night alarm 
level 

1..9 

94 Sensor 2 night alarm 
level 

1..9 

95 Sensor 1 night pre-
alarm level 

1..9 

96 Sensor 2 night pre-
alarm level 

1..9 

97 Alarm mode Sensor Mode, 
Module Mode 

 Sets the method used to indicate an 
alarm . 

SENSOR MODE: When remote output on 
a sensor is set ON for configured time, 
that sensor channel goes into alarm . 
When the remote output turns OFF, the 
channel stops signalling alarm . 

MODULE MODE: When the Output 
Activate command is sent to a channel 
module, that channel goes into alarm . To 
exit alarm, an Output Deactivate 
command must be sent . 

Note that the Output Activate 
command will not set an alarm in 
Sensor Mode, and turning on the 
sensor remote output will not set an 
alarm in Module Mode . 

Note that when in Module Mode, an 
alarm is not latched . 

In common chamber (2 sensor) 
version – the Sensor Mode is 
required to enable the AND/OR 
option . 

98 Sensor communication 
timeout 

0 (Not Used), 
1…240 s 

 The device will give a sensor 
communication fault when a sensor is 
inactive for this period of time . 

Inactive means that sensor remote 
output is OFF and it is not blinking . 

99 Remote output time for 
alarm 

50, 100, . . .10000ms    The device will go to alarm if the sensor 
remote output is ON at least for this time . 

Not applicable when Alarm Mode is 
set to Module Mode . 
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B2: FAAST LT DEFAULT SET-UP VALUES

All the default value settings are listed in the following two tables. 
Table AB2 refers to Stand Alone units, whilst Table AB3 refers to 
Loop Based (addressable) units.  

X means that a parameter is not applicable.

* value set to Italian time zone at manufacture.

Table AB2: Stand Alone Versions

# PARAMETER PARAMETER RANGE 1 Channel 
1 Sensor 

1 Channel 
2 Sensor 

2 Channel 
2 Sensor 

1 Maintenance Password 1111 - 9999 3111 3111 3111 
2 Current configuration number 0 . .255 1 1 1 
3 Current configuration date DD/MM/YY HH:MM:SS * * * 
4 Channel 1 enabled YES/NO YES YES YES 
5 Channel 2 enabled YES/NO X X YES 
6 Sensor 1 enabled YES/NO YES YES YES 
7 Sensor 2 enabled YES/NO X YES YES 
8 Daylight saving enabled YES/NO/AUTO NO NO NO 
9 Daylight saving start date  DD/MM HH:MM 25/02 02:00 25/02 02:00 25/02 02:00 
10 Daylight saving end date  DD/MM HH:MM 28/10 02:00 28/10 02:00 28/10 02:00 

11 Disable time 1..240 min 60 60 60 
12 Maintenance timeout 1..30 min or 0 (DISABLED) 5 5 5 
13 Trend log interval 1..240 min or 0 (DISABLED) 0 0 0 
14 Sensors blinking replicated  YES/NO YES YES YES 
15 Both supplies monitored YES/NO NO NO NO 
16 Number of sensors required in 

alarm 
1,2 1 1 1 

17 Sounder automatic cut-off time 0 (Disabled), 5,10,15,…,600 s 0 0 0 
18 Channel 1 alarm is latched YES/NO YES YES YES 
19 Channel 2 alarm is latched YES/NO YES YES YES 
20 Alarm delay 0 ..240 s 0 0 0 

21 Auxiliary relay is used for channel 2 
faults 

YES/NO YES YES YES 

22 Channel 1 label 16 char (ASCII code from 32 to 127) “1” “1” “1” 
23 Channel 2 label 16 char (ASCII code from 32 to 127) X X “2” 
24 Channel 1 fan speed mode Manual, Auto Auto Auto Auto 
25 Channel 2 fan speed mode Manual, Auto X X Auto 
26 Channel 1 manual fan speed 0..10 X X X 
27 Channel 2 manual fan speed 0..10 X X X 
28 Reference flow for channel 1 32 – 65 litres/min 45 litres/min 45 litres/min 45 litres/min 
29 Reference flow for channel 2 32 – 65 litres/min X X 45 litres/min 
30 High flow threshold for channel 1 Internal Setting set to EN54-20 requirements ( -20% - +20%) 
31 High flow threshold for channel 2 Internal Setting X X As Above 
32 Low flow threshold for channel 1 Internal Setting set to EN54-20 requirements ( -20% - +20%) 
33 Low flow threshold for channel 2 Internal Setting X X As Above 
34 Flow fault delay 0..240 s 60 60 60 
35 Channel 1 filter due date DD/MM/YY 01/01/99 01/01/99 01/01/99 
36 Channel 2 filter due date DD/MM/YY X X 01/01/99 
37 General fault is latched YES/NO NO NO NO 
38 General fault delay 0..240 s 60 60 60 
39 Pressure 68758 – 110000 Pa 101325 101325 101325 
40 Power restart alert time 0 (Alert disabled), 1..240 s, 

255 (no time limit) 
0 0 0 

41 Auxiliary relay set on low/high 
temperature alert 

YES/NO NO NO NO 

42 Auxiliary relay set on external input 
in not normal state 

YES/NO NO NO NO 

43 Auxiliary relay set on low power 
alert / high power fault 

YES/NO NO NO NO 
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# PARAMETER PARAMETER RANGE 1 Channel 
1 Sensor 

1 Channel 
2 Sensor 

2 Channel 
2 Sensor 

44 Auxiliary relay set on flow fault YES/NO NO NO NO 
45 Auxiliary relay set on sensor 

communication fault  
YES/NO NO NO NO 

46 Auxiliary relay set on power restart 
alert  

YES/NO NO NO NO 

47 Auxiliary relay is latched YES/NO NO NO NO 
48 External input normal state OPEN, SHORT OPEN OPEN OPEN 
49 External input triggers fault  YES/NO NO NO NO 
50 External input silences sounders YES/NO NO NO NO 
51 External input reset device YES/NO YES YES YES
52 External input disables ASD YES/NO NO NO NO 
53 External input ASD disabling time 1..1440 min 60 60 60 
54 Pre-alarm delay 0 (OFF), 1..240 s 0 0 0 
55 Pre-alarm and Alarm are in 

cascade 
YES, NO NO NO NO 

58 Day start time HH:MI 08:00 08:00 08:00 
59 Day end time HH:MI 17:00 17:00 17:00 
60 Holiday day #1 date DD/MM empty empty empty 
 … DD/MM empty empty empty 
79 Holiday day #20 date DD/MM empty empty empty 
80 Sounder activation mode On Pre-alarm, On Alarm Alarm Alarm Alarm
81 Day/night mode enabled YES/NO NO NO NO 
82 Monday is holiday YES/NO NO NO NO 
83 Tuesday is holiday YES/NO NO NO NO 
84 Wednesday is holiday YES/NO NO NO NO 
85 Thursday is holiday YES/NO NO NO NO 
86 Friday is holiday YES/NO NO NO NO 
87 Saturday is holiday YES/NO NO NO NO 
88 Sunday is holiday YES/NO NO NO NO 
89 Sensor 1 day alarm level 1..9 1 1 1 
90 Sensor 2 day alarm level 1..9 1 1 1 
91 Sensor 1 day pre-alarm level 1..9 1 1 1 
92 Sensor 2 day pre-alarm level 1..9 1 1 1 
93 Sensor 1 night alarm level 1..9 1 1 1 
94 Sensor 2 night alarm level 1..9 1 1 1 
95 Sensor 1 night pre-alarm level 1..9 1 1 1 
96 Sensor 2 night pre-alarm level 1..9 1 1 1 
97 Alarm mode Sensor alarm mode, module alarm 

mode 
X X X  

98 Sensor communication timeout 0 (Disabled),1…240 s X X X 
99 Remote output time for alarm 50, 100,...10000ms X X X  
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Table AB3: Loop Based (Addressable) Versions

# PARAMETER PARAMETER RANGE 1 Channel 
1 Sensor 

1 Channel 
2 Sensor 

2 Channel 
2 Sensor 

1 Maintenance Password 1111 - 9999 3111 3111 3111 
2 Current configuration number 0 . .255 1 1 1 
3 Current configuration date DD/MM/YY HH:MM:SS * * * 
4 Channel 1 enabled YES/NO YES YES YES 
5 Channel 2 enabled YES/NO X X YES 
6 Sensor 1 enabled YES/NO YES YES YES 
7 Sensor 2 enabled YES/NO X YES YES 
8 Daylight saving enabled YES/NO/AUTO NO NO NO 
9 Daylight saving start date  DD/MM HH:MM 25/02  02:00 25/02  02:00 25/02  02:00 
10 Daylight saving end date  DD/MM HH:MM 28/10  02:00 28/10  02:00 28/10  02:00 

11 Disable time 1..240 min 60 60 60 
12 Maintenance timeout 1..30 min or 0 (DISABLED) 5 5 5 
13 Trend log interval 1..240 min or 0 (DISABLED) 0 0 0 
14 Sensors blinking replicated  YES/NO YES YES YES 
15 Both supplies monitored YES/NO NO NO NO 
16 Common chamber sensors 

required for alarm 
1,2 1 1 1 

17 Sounder automatic cut-off time 0 (Disabled), 5,10,15,…,600 s 0 0 0 
18 Channel 1 alarm is latched YES/NO NO NO NO 
19 Channel 2 alarm is latched YES/NO NO NO NO 
20 Alarm delay 0 ..240 s 0 0 0 

21 Auxiliary relay is used for channel 2 
faults 

YES/NO YES YES YES 

22 Channel 1 label 16 char (ascii code from 32 to 127) “1” “1” “1” 
23 Channel 2 label 16 char (ascii code from 32 to 127) X X “2” 
24 Channel 1 fan speed mode Manual, Auto Auto Auto Auto 
25 Channel 2 fan speed mode Manual, Auto X X Auto 
26 Channel 1 manual fan speed 0..10 X X X 
27 Channel 2 manual fan speed 0..10 X X X 
28 Reference flow for channel 1 32 – 65 litres/min 45 litres/min 45 litres/min 45 litres/min 
29 Reference flow for channel 2 32 – 65 litres/min X X 45 litres/min 
30 High flow threshold for channel 1 Internal Setting set to EN54-20 requirements (-20% - +20%) 
31 High flow threshold for channel 2 Internal Setting X X As Above 
32 Low flow threshold for channel 1 Internal Setting set to EN54-20 requirements (-20% - +20%) 
33 Low flow threshold for channel 2 Internal Setting X X As Above 
34 Flow fault delay 0..240 s 60 60 60 
35 Channel 1 filter due date DD/MM/YY 01/01/99 01/01/99 01/01/99 
36 Channel 2 filter due date DD/MM/YY X X 01/01/99 
37 General fault is latched YES/NO NO NO NO 
38 General fault delay 0..240 s 0 0 0 
39 Pressure 68758 – 110000 Pa 101325 101325 101325 
40 Power restart alert time 0 (Alert disabled), 1..240 s, 255 (no 

time limit) 
0 0 0 

41 Auxiliary relay set on low/high 
temperature alert 

YES/NO NO NO NO 

42 Auxiliary relay set on external input 
in not normal state 

YES/NO NO NO NO 

43 Auxiliary relay set on low power 
alert / high power fault 

YES/NO NO NO NO 

44 Auxiliary relay set on flow fault YES/NO NO NO NO 
45 Auxiliary relay set on sensor 

communication fault  
YES/NO NO NO NO 

46 Auxiliary relay set on power restart 
alert  

YES/NO NO NO NO 

47 Auxiliary relay is latched YES/NO NO NO NO 
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# PARAMETER PARAMETER RANGE 1 Channel 
1 Sensor 

1 Channel 
2 Sensor 

2 Channel 
2 Sensor 

48 External input normal state OPEN, SHORT OPEN OPEN OPEN 
49 External input triggers fault  YES/NO NO NO NO 
50 External input silences sounders YES/NO NO NO NO 
51 External input reset device YES/NO YES YES YES
52 External input disables ASD YES/NO NO NO NO 
53 External input ASD disabling time 1..1440 min 60 60 60 
54 Pre-alarm delay 0 (OFF), 1..240 s X X X 
55 Pre-alarm and Alarm are in 

cascade 
YES, NO X X X  

58 Day start time HH:MI X X X  
59 Day end time HH:MI X X X 
60 Holiday day #1 date DD/MM X X X  
 … DD/MM X X X 
79 Holiday day #20 date DD/MM X X X  
80 Sounder activation mode On Pre-alarm, On Alarm X X X 
81 Day/night mode enabled YES/NO X X X  
82 Monday is holiday YES/NO X X X 
83 Tuesday is holiday YES/NO X X X 
84 Wednesday is holiday YES/NO X X X 
85 Thursday is holiday YES/NO X X X 
86 Friday is holiday YES/NO X X X 
87 Saturday is holiday YES/NO X X X 
88 Sunday is holiday YES/NO X X X 
89 Sensor 1 day alarm level 1..9 X X X 
90 Sensor 2 day alarm level 1..9 X X X  
91 Sensor 1 day pre-alarm level 1..9 X X X  
92 Sensor 2 day pre-alarm level 1..9 X X X 
93 Sensor 1 night alarm level 1..9 X X X  
94 Sensor 2 night alarm level 1..9 X X X  
95 Sensor 1 night pre-alarm level 1..9 X X X 
96 Sensor 2 night pre-alarm level 1..9 X X X  
97 Alarm mode Sensor alarm mode, module alarm 

mode 
Sensor Sensor Sensor 

98 Sensor communication timeout 0 (Disabled),1…240 s 0 0 0 
99 Remote output time for alarm 50, 100,...10000ms 3000 3000 3000 
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APPENDIX C
PIPE CONFIGURATION TYPICAL EXAMPLES - 1 CHANNEL (can be duplicated for 2 channel units)
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